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Introduction

The following two optical-to-electrical converters are described in this guide.

• N7004A 33 GHz optical-to-electrical converter

• N7005A 60 GHz optical-to-electrical converter

These optical-to-electrical converters directly convert optical signals into electrical signals for 
convenient analysis on a compatible Infiniium real-time oscilloscope. 

N7004A and N7005A have a high-sensitivity photodetector module with an FC/PC input connector 
to receive optical telecom or datacom signals from an optical source/transmitter through a fiber 
optic patch cable. The N7004A supports transmission through a single-mode as well as a multimode 
fiber. The N7005A supports transmission through a single-mode fiber.

The O/E output connector of N7004A / 5A connects to the oscilloscope’s channel to provide its 
electrical output to the oscilloscope for analysis.

N7004A Components

Figure 1 N7004A Optical-to-Electrical Converter - Components

NOTE
The N7004A O/E Converter is designed for use with oscilloscopes that have 
AutoProbe II interface channel inputs. 
The N7005A O/E Converter is designed for use with oscilloscopes that have 
AutoProbe III interface channel inputs. 

The AutoProbe interface provides power to the N7004A /5A as well as 
ensures the auto-configuration of probe type and attenuation settings when 
you connect the N7004A /5A to the oscilloscope. 

O/E Output 
Connector

(For providing 
electrical output 

to the 
oscilloscope’s 

channel)

Fiber-optic 
Receptacle with 

FC/PC Input 
Connector

Plastic cap for the FC/PC 
Input Connector 

AutoProbe II Interface 
Connector

(For probe power and 
auto-configuration on 

connection to oscilloscope)
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N7005A Components

Figure 2 N7005A Optical-to-Electrical Converter - Components

O/E Output 
Module

(For providing 
electrical output 

to the 
oscilloscope’s 

channel)

Fiber-optic Receptacle 
with FC/PC Input 

Connector

AutoProbe III Interface 
Module 

(For probe power and 
auto-configuration on 

connection to oscilloscope)
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Usage

The following are the broad usage scenarios of N7004A / 5A with an Infiniium real-time oscilloscope 
as an optical measurement solution.

• To view the raw (unfiltered) response of the optical source/transmitter under test.

• To make industry-standard optical measurements on the optical source/transmitter under test. 
The N7004A and N7005A support 4th Order Bessel Thomson filter to help you accomplish this. 

• To perform system-level troubleshooting and characterization for the optical source(s) used in 
your optical system. 

• To test system boards with an embedded optical transceiver in scenarios where there is no clock 
signal. The N7004A / 5A and real-time oscilloscope setup does not require an external clock 
source to trigger the oscilloscope for capturing data. 

• To view and troubleshoot a one-time, transient single-shot event. 

• To make optical PAM4 measurements including Transmitter Dispersion and Eye Closure 
Quaternary (TDECQ), Outer Extinction Ratio (ER), Outer Optical Modulation Amplitude (OMA), and 
Average Optical Power using N7005A. The high bandwidth supported by N7005A is specifically 
suited to cover 56 Gbaud optical PAM4 measurements. 



N7004A / 5A Optical-to-Electrical-Converters User’s Guide 11

Overview 1

Features

Refer to page 15 for the complete set of specifications and characteristics for N7004A / 5A.

N7004A N7005A

Allows you to view optical streams at speeds up to 28 Gbps. Allows you to view optical streams at speeds up to 56 Gbaud 
PAM4.
Allows you to make the TDECQ optical measurement using the 
FlexRT software GUI which can be launched from the Infiniium GUI 
(see page 37)

Supports DC to 33 GHz of electrical bandwidth. Supports DC to 60 GHz of electrical bandwidth.

Supports single-mode as well as multimode fibers.
(See page 15 for supported wavelength ranges and 
conversion gain.)

Supports single-mode fiber.
(See page 15 for supported wavelength ranges and conversion 
gain.)

Designed for use with oscilloscopes that have AutoProbe II 
interface channel inputs. 

Designed for use with oscilloscopes that have AutoProbe III 
interface channel inputs. 

Supports the following filter types:
- Brickwall filter

- 4th Order Bessel Thomson filter
- Butterworth filter (available only on UXR-series oscilloscopes)

Built-in unique s-parameter correction filters to ensure a flat frequency response thereby yielding more accurate measurements. The 
system response is automatically corrected on connecting the N7004A/5A to the oscilloscope. 

Allows you to improve the accuracy of the extinction ratio measurement by providing the option of Dark Calibration which is 
performed by covering the optical input of the N7004A / 5A. The optical power reading thus obtained from dark calibration is 
subtracted from the optical measurements to achieve accuracy in measurements.

Use either front panel controls on the oscilloscope or remote programs to set up, configure, and make measurements using the 
N7004A / 5A.

Supports built-in trigger source. You need not configure a trigger setup explicitly for making optical measurements using the 
N7004A / 5A.

Allows you to make critical optical signals measurements in real time with an Infiniium real-time oscilloscope. 
In the Infiniium software GUI, you get:
- a suite of optical measurements (see page 40) with data presented in watts.
- features for eye-mask testing and measuring eye diagram parameters including extinction ratio.
- features for loading masks with margin or drawing your own mask or create an automask.

Provides a built-in software reference receiver filter. The reference receiver measurement is made with a 4th Order Bessel Thomson 
filter set to 75% of the data rate. This reduces the effects of the transmitter’s high frequency overshoot and noise.
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Compatible Oscilloscopes

For N7004A

For N7005A

N7004A Compatible Oscilloscopes Adapter Required  Oscilloscope Software

- V-Series 
- Z-Series 
- 90000 Q-Series
- 90000 X-Series 

None Infiniium baseline software version 5.70 or 
higher

UXR-Series (13-33 GHz) None Infiniium baseline software version 
10.25.00702 or higher

UXR-Series (40 GHz or higher)  N2852A AutoProbe II to AutoProbe 
III Interface adapter)

Infiniium baseline software version 
10.25.00702 or higher

NOTE
The N2852A AutoProbe II to AutoProbe III Interface adapter allows you to 
connect the N7004A (with the AutoProbe II interface) to a Keysight UXR-Series 
40 GHz or higher Infiniium oscilloscope (with the AutoProbe III interface).

To know more about the N2852A adapter, visit 
http://www.keysight.com/find/N2852A and then download the adapter’s user 
guide available in the Document Library tab.

CAUTION
Care should be taken while handling the N2852A adapter's RF cable. Avoid 
bending this cable backwards or kinking the cable to ensure measurements 
accuracy.

N7005A Compatible Oscilloscopes Adapter Required  Oscilloscope Software

UXR-series (40 GHz or higher)
with 1.85 mm AutoProbe III Interface

1.85 mm F - F adapter available with 
the UXR oscilloscope
(p/n - 85058-60114)

For optical measurements and Infiniium based dark 
calibration
• Infiniium baseline software version 10.25.00702 

or higher
For TDECQ measurement features (see page 37)
• Infiniium baseline software version 10.25 Patch 

6 or higher
• FlexRT software 

• N1010A FlexDCA oscilloscope software 
version A.06.70 or higher

• N1010200A Manufacturing license to make 
the TDECQ measurement

• N1010100A RND license if you want to run 
the FlexRT application from a remote PC 
connected to the real-time oscilloscope. 
This license also allows you to make the 
TDECQ measurement.

UXR-series (40 GHz or higher)
with 1 mm AutoProbe III Interface

1 mm Ruggedized F - 1.85 mm F 
adapter available as an optional UXR 
oscilloscope accessory.
(p/n - Y1901B)

http://www.keysight.com/find/N2852A
http://www.keysight.com/find/N2852A
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Is Your Oscilloscope Software Up-to-Date?

Keysight periodically releases software updates to support your probe, fix known defects, and 
incorporate product enhancements. To download the latest firmware, go to www.keysight.com and 
search for your oscilloscope’s series. Then click on the “Drivers, Firmware & Software” tab.

www.keysight.com
www.keysight.com
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Oscilloscope Bandwidth Requirements

You can use the following calculations to determine the real-time oscilloscope bandwidth needed 
when using the N7004A or N7005A. 

For NRZ (PAM2) Signals

Oscilloscope bandwidth requirement >= Optical data rate (Gbps) * 0.75 * 3/2
For example, if the optical data rate is 10 Gbps, then the oscilloscope bandwidth requirement is:

10 Gbps * 0.75 * 3/2 which is equal to 11.25 GHz.

Based on the above calculations, the following table provides the recommended bandwidth of the compatible Infiniium oscilloscopes 
for NRZ (PAM2) signals measurements.

Optical Data Rates Reference Receiver Bessel 
Thomson Bandwidth
(0.75 * optical data rate)

Oscilloscope Bandwidth Requirement
(3/2 * Reference Receiver Bandwidth)

Recommended 
Oscilloscope Bandwidth 

28 Gbps 21 GHz >31.5 GHz For N7004A
V-series 33 GHz 
Z-series 33 GHz 
UXR-series 33 GHz 

For N7005A 
UXR-series 40 GHz 

For PAM4 Signals (applicable to N7005A only)

Oscilloscope bandwidth requirement >= Optical symbol rates in Gbaud * 0.5 * 3/2
For example, if the optical data rate is 56 Gbps (28 Gbaud) then the oscilloscope bandwidth requirement is:

28 Gbaud * 0.5 * 3/2 which is equal to 21 GHz.

Based on the above calculations, the following table provides the recommended bandwidth of the compatible Infiniium oscilloscope 
for PAM4 signals measurements.

Optical Data 
Rates

Optical Symbol 
Rates

Reference Receiver Bessel 
Thomson Bandwidth
(0.75 * optical data rate)

Oscilloscope Bandwidth 
Requirement
(3/2 * Reference Receiver 
Bandwidth)

Recommended 
Oscilloscope Bandwidth 

56 Gbps 28 Gbaud 14 GHz >21 GHz For N7005A 
UXR-series 40 GHz 

112 Gbps 56 Gbaud 28 GHz >42 GHz For N7005A 
UXR-series 70 GHz 
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N7004A and N7005A Specifications and Characteristics

Environmental Specifications

Bandwidth Performance Specification

Optical and Electrical Characteristics

Characteristic N7004A N7005A

Use For indoor use only

Temperature Operating +10 °C to +40 °C (50 °F to +104 °F)
Non-operating -40 °C to +70 °C (-40 °F to +158 °F)

Operating +10 °C to +55 °C (50 °F to +131 °F)
Non-operating -40 °C to +70 °C (-40 °F to +158 °F)

Altitude  Up to 4,600 meters (15,000 ft)  Up to 4,600 meters (15,000 ft)

Maximum relative 
humidity 

80% for temperatures up to 31 °C decreasing 
linearly to 50% relative humidity at 40 °C

80% for temperatures up to 31 °C decreasing linearly 
to 50% relative humidity at 40 °C

Weight 350 g (0.77 lbs) 410 g (0.9 lbs) 

Dimensions Refer to the topic “N7004A Dimensions" on 
page 16.

Refer to the topic “N7005A Dimensions" on page 17.

Specification N7004A N7005A

Bandwidth, warranted 
(electrical, –3 dB)

32 GHz (with Brickwall filter)
21.3 GHz (with 4th order Bessel Thomson filter)

60 GHz (with Brickwall filter)
46.6 GHz (with 4th order Bessel Thomson filter)

Specifications are the performance standards against which the product is tested. It represents warranted performance of a calibrated 
instrument.

Characteristic N7004A N7005A

Bandwidth, typical (electrical, 
–3 dBe)

33 GHz (with Brickwall filter)
22 GHz (with 4th order Bessel Thomson filter)

60 GHz (with Brickwall filter)
46.6 GHz (with 4th order Bessel Thomson filter)

Rise time (10 to 90%), typical 13.3 psec (with Brickwall filter)
17.7 psec (with 4th order Bessel Thomson filter)

7.3 psec (with Brickwall filter)
8.4 psec (with 4th order Bessel Thomson filter)

Rise time (20 to 80%), typical 9.4 psec (with Brickwall filter)
12.3 psec (with 4th order Bessel Thomson filter)

5.2 psec (with Brickwall filter)
5.8 psec (with 4th order Bessel Thomson filter)

Optical output coupling DC

Wavelength range 750 to 1650 nm (including factory-calibrated 
850, 1310 nm, and 1550 nm)

1250 nm to 1600 nm (including factory-calibrated 
1310 nm and 1550 nm)

RMS noise (uW) See the noise characteristics table in the data sheet

Conversion gain (V/W) 850 nm multimode: 68 (min), 75 (typical)
1310 nm multimode/single-mode: 105 (min), 
110 (typical)
1550 nm single-mode: 105 (min), 110 (typical)

1310 nm single-mode: 85 (min), 93 (typical)
1550 nm single-mode: 72 (min), 85 (typical)

Maximum linear input power 4 mW

Maximum non-destructive 
input power

8 mW
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N7004A Dimensions

The N7004A dimensions shown below are in Inches.

Figure 3 N7004A Dimensions

Input return loss (dB) 850 nm multimode: –17 (typical), –15 (max) 
(fully filled fiber)
1310 nm single-mode: –18.5 (typical), –16 (max)
1550 nm single-mode: –14 (typical)

1310 nm single-mode: -25 (max)
1550 nm single-mode: -25 (max)

Connector type FC/PC to 50/125 µm fiber 
Compatible with single-mode or multimode 
fibers

FC/PC to 9/125 µm fiber 
Compatible with single-mode fiber

Oscilloscope Interface AutoProbe II AutoProbe III 

Characteristic N7004A N7005A
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N7005A Dimensions

The N7005A dimensions shown below are in Inches [mm].

Figure 4 N7005A Dimensions
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Step 1 - Clean the Fiber-Optic Connectors

Fiber-optic connectors are very sensitive, easy to damage, and expensive to replace. These 
connectors can be easily damaged when connected to dirty or damaged cables and accessories. 
Therefore, you must clean the fiber ends of the N7004A / 5A fiber-optic connector and the mating 
fiber-optic cable or patch cable before each and every time a connection is made. 

To visually inspect the fiber-ends

The visual inspection of the fiber-ends can help you identify any damage to the ferrule or end of the 
fiber, any stray particles, or finger oil that can have a significant effect on connector performance. 

The following picture shows the end of a clean, problem-free fiber-optic connector. The dark center 
circle is the fiber's 125 mm core and cladding which carries the light. The surrounding area is the 
ferrule.

The following picture shows a fiber end that is dirty from neglect or improper cleaning. Loose 
particles or oils are smeared and ground into the end of the fiber causing light scattering and poor 
reflection. Not only is the precision polish lost, but this action can also grind off the glass face and 
destroy the connector.

The following picture shows physical damage to the glass fiber end caused by either repeated 
connections made without removing loose particles from the fiber end or by using improper cleaning 
tools. This damage can be severe enough to transfer the damage from the connector end to a good 
connector that comes in contact with it.

CAUTION
Damage to the fiber-optic connectors can:

• Degrade measurement accuracy and repeatability. 

• Cause expensive damage to instruments.

Repair of the N7004A / 5A connector damaged due to lack of cleaning, 
improper use, or improper cleaning procedures is NOT covered under 
warranty.

NOTE
Keep fiber-optic connectors covered when not in use. The N7004A / 5A 
shipment includes protective plastic caps for covering its fiber-optic 
connector.
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Use a microscope (100X to 200X magnification) to inspect the entire end face for contamination, 
raised metal, dents in the metal, and any other imperfections. Visible imperfections not touching the 
fiber core may not affect performance, unless the imperfections keep the fibers from contacting.

To clean the fiber-end of the N7004A / 5A fiber-optic connector

1 Lift the latch of the fiber-optic connector.

2 Carefully pull off the receptacle without touching the ferrule or fiber end. This will expose the 
fiber-end for cleaning.

3 Clean the fiber-optic end using a professional fiber-optic cleaning product. A variety of products 
are available and are easily located via an Internet search on "fiber optic cleaning products". You 
can purchase tools designed specifically for the type of fiber-optic cable that you are using. You 
can also use a cloth or a swab with alcohol to clean. 

WARNING
Always remove both ends of fiber-optic cables from any instrument, system, 
or device before visually inspecting the fiber-ends. Disable all optical 
sources before disconnecting fiber-optic cables. Failure to do so may result 
in permanent injury to your eyes.
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To clean the fiber-end of the mating patch cable

1 Use a clean wipe each time you need to clean the mating cable. Wipes that are available in a 
dispenser are recommended for cleaning.

CAUTION
Never use metal or sharp objects to clean a connector and never scrape the 
connector.

WARNING
If flammable cleaning materials are used, the material shall not be stored, or 
left open in the area of the equipment. Adequate ventilation shall be assured 
to prevent the combustion of fumes, or vapors. Ensure that the disposal of 
cleaning materials is done in a manner consistent with local regulations.

WARNING
Cleaning connectors with alcohol shall only be done with the instruments 
power cord removed, and in a well-ventilated area. Allow all residual alcohol 
moisture to evaporate and the fumes to dissipate prior to energizing the 
instrument.

CAUTION
Do not use any type of foam swab to clean optical fiber ends. Foam swabs 
can leave filmy deposits on fiber ends that can degrade performance.

CAUTION
Do not scrub during this initial cleaning because grit can be caught in the 
swab and become a gouging element.
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CAUTION
Do not shake, tip, or invert compressed air canisters, because this releases 
particles in the can into the air. Refer to instructions provided on the 
compressed air canister.

CAUTION
Keysight Technologies strongly recommends that index matching 
compounds not be applied to their instruments and accessories. Some 
compounds, such as gels, may be difficult to remove and can contain 
damaging particulates. If you think the use of such compounds is necessary, 
refer to the compound manufacturer for information on application and 
cleaning procedures.
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Step 2 - Connect the N7004A / 5A Output to a Compatible Keysight Oscilloscope

On connecting, 

• The oscilloscope automatically recognizes the N7004A / 5A. 

• The s-parameters are automatically read to adjust the system response and the N7004A / 5A is 
displayed in the Infiniium software GUI for setup and configuration. 

• The vertical unit is changed to Watts in the Infiniium software GUI.

CAUTION
When using N7005A, ensure that it is not connected to the optical signal 
until both its modules (AutoProbe III interface module and O/E module) are 
connected to the oscilloscope.
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Step 3 - Connect a Fiber-optic Cable to the N7004A / 5A Optical Input Connector 

Fiber-optic Cable Selection

• With N7004A, you can use a 9/125 µm single-mode or a 50/125 µm multimode fiber-optic cable 
that has an FC/PC connector. With N7005A, you can use a 9/125 µm single-mode fiber-optic 
cable that has an FC/PC connector. 

• If your fiber has a connector other than FC/PC, then you can use a LC-to-FC or SC-to-FC patch 
cord to establish connectivity with the N7004A / 5A. 

• If your fiber has a FC/APC connector, use a fiber patch cord with FC/UPC to connect to the O/E 
side of N7005A and FC/APC to connect to the target.

• Ensure that you use a fiber patch cord with ceramic fiber-optic ferrule.

Guidelines for Making the Connection

When inserting a fiber-optic cable into a connector:

• Gently insert the fiber-optic cable in as straight a line as possible. Tipping and inserting at an 
angle can scrape material off the inside of the connector or even break the inside sleeve of 
connectors made with ceramic material.

• Ensure that the fiber end does not touch the outside of the mating connector or adapter.

• Avoid over tightening connections. Unlike common electrical connections, tighter is not better. 
The purpose of the connector is to bring two fiber ends together. Once they touch, tightening only 
causes a greater force to be applied to the delicate fibers.

With connectors that have a convex fiber end, the end can be pushed off-axis resulting in 
misalignment and excessive return loss. Many measurements are actually improved by backing 
off the connector pressure. Also, if a piece of grit does happen to get by the cleaning procedure, 
the tighter connection is more likely to damage the glass. Tighten the connectors just until the 
two fibers touch.

• Use fusion splices on the more permanent critical nodes. Choose the best connector possible. 
Replace connecting cables regularly. Frequently measure the return loss of the connector to 
check for degradation, and clean every connector, every time.

Aligning the Keying Features while Making the Connection

While securing the connection between the N7004A / 5A and fiber-optic cable, ensure that the 
keying features of both the N7004A/5A FC/PC Input connector and fiber-optic cable’s connector are 
aligned properly before you start finger-tightening the connection. Misaligned keys can adversely 
affect the optical signal transmission. 

WARNING
Ensure that all connections to N7004A / 5A are secure prior to enabling any 
laser source.

CAUTION
To avoid damage to the fiber-optic connector, use proper cleaning 
techniques. Refer to “Step 1 - Clean the Fiber-Optic Connectors" on 
page 20.
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The following are the examples of finger-tightened connections, one with the keying features 
properly aligned and the other with the keying features misaligned. 

Correct way of connecting - Keying 
features are proper aligned 

Incorrect way of connecting - 
Keying features are misaligned 

CAUTION
The input circuitry of the N7004A / 5A can be damaged when total input 
power levels exceed 8 mW. To prevent damage, this specified level must not 
be exceeded.
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Step 4 - Configure the N7004A / 5A Setup on the Infiniium Software

Selecting the Wavelength

1 In the Infiniium software GUI, choose Setup > Probe Configuration... to open the Probe Configuration 
dialog box. Notice that the N7004A / 5A is recognized and displayed as connected to the scope’s 
channel.

2 Click Options... displayed under N7004A / 5A to set the wavelength for N7004A / 5A.

3 Select the required wavelength. N7004A and N7005A support the following wavelengths:
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N7004A Supported Wavelengths

N7005A Supported Wavelengths

Adjusting Conversion Gain for a User-defined Wavelength

If you select a predefined wavelength, the N7004A / 5A’s predefined responsivity value for this 
wavelength is displayed in the Responsivity field. Based on the selected predefined wavelength, the 
N7004A / 5A’s conversion gain is therefore automatically adjusted to provide an accurate 
measurement of the signal’s average optical power.

Responsivity Vs. Wavelength for N7004A

Predefined 
(Factory-calibrated) 
Wavelengths

User-defined Wavelengths

850 nm Wavelength should be in the range of 
750 to 1650 nm.

1310 nm

1550 nm

Predefined 
(Factory-calibrated) 
Wavelengths

User-defined Wavelengths

1310 nm Wavelength should be in the range of 
1250 to 1600 nm.

1550 nm

Wavelength
Responsivity (Conversion Gain)

Minimum Typical 

850 nm Multimode: 68 V/W Multimode: 75 V/W 

1310 nm Multimode/Single Mode: 105 V/W Multimode/Single Mode: 110 V/W

1550 nm Single Mode: 105 V/W Single Mode: 110 V/W

User-defined To be manually adjusted
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Responsivity Vs. Wavelength for N7005A

If you select the User Defined wavelength option, then you need to manually specify and adjust the 
Responsivity value in the Responsivity field to adjust the N7004A / 5A’s conversion gain for this 
user-defined wavelength. 

To determine the responsivity value for a user-defined wavelength

1 Measure the optical signal using an optical power meter.

2 Transmit this signal to the N7004A / 5A. This may be an active signal or just a DC optical level. 

3 Set up the Vaverage measurement for the waveform on the Infiniium software GUI. This 
measurement is available under the Vertical Measurements group. 

Wavelength
Responsivity (Conversion Gain)

Minimum Typical 

1310 nm Single Mode: 85 V/W Single Mode: 93 V/W

1550 nm Single Mode: 72 V/W Single Mode: 85 V/W

User-defined To be manually adjusted



2 Setting up the N7004A / 5A O/E Converter

30 N7004A / 5A Optical-to-Electrical-Converters User’s Guide

4 For the user-defined wavelength, the Responsivity field is enabled to allow you to adjust the 
responsivity value. Adjust the Responsivity value in this field until the Vaverage measurement 
agrees with the power level determined by the optical power meter in step1.

Configuring the Bandwidth Limits for the Oscilloscope and its Channel

Set the bandwidth limit for the oscilloscope and the individual channel to which you have connected 
the N7004A / 5A using the Bandwidth Limit dialog box. You may want to reduce bandwidth settings 
for improved noise performance. For details on how to set bandwidth limits on the oscilloscope, click 
the  icon in the Bandwidth Limit dialog box. 

Individual Channel Bandwidth Limit Filters

When setting the bandwidth limits, you can select one of the following two bandwidth limit filters for 
the channel to which the N7004A / 5A is connected. 

NOTE
On selecting the User-defined wavelength option, the Optical Average Power 
measurement displays the value “Responsivity?” instead of the average optical power 
value. This is because this measurement is calibrated based on the selected wavelength 
and in case of a user-defined wavelength, there is no calibration factor available for this 
measurement. 
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Adjusting the Vertical Settings for the Oscilloscope Channel

Adjust the vertical scale (Watts per division) and offset settings for the oscilloscope channel to which 
you connected the N7004A / 5A. For the extinction ratio measurement, this step is critical as the 
vertical settings affect the magnitude of the dark level offset which can affect the accuracy of this 
measurement.

You can adjust the vertical settings using the options displayed in the Infiniium software GUI or using 
the vertical scale and offset knobs of the oscilloscope.

Adding and Configuring Optical Measurements

1 Click Measure > Add Measurement to access the Add Measurement dialog box. 

2 Select and add the required optical measurements from the set of measurements displayed 
under the Optical group in the Add Measurement dialog box.

Brickwall 4th Order Bessel Thomson (BT4)

Suitable when you want to characterize the raw response of the optical 
transmitter under test. 

Suitable when you want to do reference receiver testing of industry-standard 
optical measurements on the optical transmitter under test. 
This filter limits the bandwidth to optimize the signal-to-noise ratio but does 
not lower it down to the extent of causing inter-symbol interference. This 
allows the waveform to be displayed similar to what a receiver would see.

The maximum bandwidth limit that you can specify can be the same as 
the N7004A / 5A’s bandwidth limit, that is, 33 GHz and 60 GHz 
respectively.

For NRZ signals:
The maximum bandwidth limit that you can specify is about 2/3 of the 
maximum bandwidth you could specify with the Brickwall filter. 
For a 33 GHz oscilloscope with the Bessel Thomson filter on, this yields a 22 
GHz BT4, which covers 28 Gbps x 0.75 = 21 GHz.
For PAM4 signals:
The BT4 electrical bandwidth of a PAM4 signal is set to a frequency 
corresponding to 50% of the symbol rate. For example, to set a BT4 filter for 
56 Gbaud PAM4 measurement, you will need to set the filter frequency to 28 
GHz BT4.

While setting up the bandwidth limits, refer to the topic “Oscilloscope Bandwidth Requirements" on page 14 to know how much oscilloscope bandwidth 
is needed based on your optical data rates / optical symbol rates requirements. 

NOTE
The Vertical scale of an oscilloscope channel is displayed in Watts when you connect the 
N7004A / 5A O/E Converter to the channel.

Adjust the vertical scale and offset levels in such a way that the output levels are completely 
on the screen and the eye diagram uses the full display.
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NOTE
For measurements such as the Extinction ratio and Outer ER, you may want to define settings 
such as eye pattern settings used to make eye waveform measurements. You can do this while 
adding the measurement using the Add Measurement dialog box. Refer to the Optical 
Measurements help topics in the online help of your Infiniium oscilloscope to get a detailed 
description of each of the optical measurements.
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Step 5 - Perform Dark Calibration on the Infiniium GUI

After you have configured the N7004A / 5A settings and the optical measurement setup on the 
Infiniium software, you can perform dark calibration. 

What is Dark Calibration

Dark calibration is the process of factoring out the power transmitted by the N7004A / 5A when there 
is no light being transmitted.
In this calibration, the oscilloscope identifies the offset (dark level) signals internally generated by 
N7004A / 5A when no light is present at the input channel. These internal offset signals are then 
removed by the oscilloscope from the extinction ratio calculations to ensure accurate measurement 
results. 

When to Perform Dark Calibration

Dark calibration is only valid for a given vertical scale, offset, and sample rate of the oscilloscope. A 
change in any of these invalidates the calibration and you have to perform dark calibration again. 
Therefore, you must perform dark calibration as the last step just before making optical 
measurements when you have set the vertical scale and offset at which you want to make your 
measurements.

Before your Perform Dark Calibration

For dark calibration accuracy, ensure that:

• both ends of the fiber-optic cable are connected.

• the laser source connected to N7004A / 5A is turned off.

NOTE
When the Extinction Ratio or Outer ER measurement is performed, the 
oscilloscope mathematically removes the offset error measured by dark 
calibration from the extinction ratio calculation. Therefore, if you plan to make 
the Extinction Ratio or Outer ER measurement, it is highly recommended that 
you perform dark calibration to maximize the accuracy in these measurement’s 
results.

A “?” is displayed with the Extinction Ratio and Outer ER measurements results if 
dark calibration is not valid.

NOTE
You need to perform dark calibration again when:

- vertical scale or offset is changed.

- sample rate is changed.

- ±1 °C temperature change from the calibration temperature.

- wavelength or responsivity is changed.

- power is recycled.
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Steps to Perform Dark Calibration

1 Allow the N7004A / 5A to warm up for15 minutes before starting the calibration.

2 Choose Setup > Probe Configuration...

The Probe Configuration... dialog box is displayed.

3 In the Calibration Status section, the Dark Cal status is currently displayed as Uncalibrated. Click the 
Cal... button.

The Probe Calibration dialog box is displayed. 

NOTE
It is recommended to cover any open optical inputs with a cap to avoid stray 
light that could impact calibration accuracy.
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4 Click the Dark Cal button to begin dark calibration. 

5 Ensure that the laser source connected to N7004A / 5A is turned off and then click OK on the 
following warning message.

If the dark calibration competes successfully, the date and time of its completion is shown on 
screen. If it fails, the status is displayed as Uncalibrated.

The setup is now complete to start making the measurements.

Reasons for the Failure of Dark Calibration

• The N7004A / 5A optical input is not covered properly to block light completely or the optical 
source is not turned off. 
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• The dark level (signal with the light source off) is not on the Infiniium screen. This signal must be 
completely on the screen to be correctly measured during dark calibration.

• The dark level (signal with the light source off) is less than 20mV converted to Watts by the 
responsivity. The dark calibration should be performed after the signal has been scaled correctly. 
It is recommended to set the vertical sensitivity of the oscilloscope so that the signal you try to 
capture takes about 5-6 divisions high.

• The dark calibration is canceled by the user.
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Configuring Software for the TDECQ Measurement - An Overview

This topic provides an overview of the software configuration steps that you need to perform on the 
Infiniium GUI and FlexRT GUI to make the TDECQ measurement using the N7005A. The Infiniium GUI 
based steps are described in detail in the previous topics of this chapter. For details on the steps that 
you need to perform on the FlexRT GUI for TDECQ, refer to the online help integrated with the FlexRT 
GUI. 

Software Requirements for the TDECQ Measurement

• Infiniium baseline software version 10.25 patch 6 or higher

• FlexRT application (N1010A FlexDCA oscilloscope software version 
A.06.70 or higher)

You can install and run FlexRT either directly on the real-time 
oscilloscope or from a remote PC connected to the real-time 
oscilloscope.

• N1010200A Manufacturing license to make the TDECQ measurement

• N1010100A RND license if you want to run the FlexRT application from a 
remote PC connected to the real-time oscilloscope. This license also 
allows you to make the TDECQ measurement.

NOTE
N1010A FlexDCA is the software for Keysight’s DCA family of sampling 
oscilloscopes. The A.06.70 or higher version of this software identifies and 
supports an Infiniium UXR-series real-time oscilloscope as an extended 
module and provides the FlexRT real-time oscilloscope application. Using 
this application, you can make the TDECQ measurement on an optical PAM4 
signal acquired using the N7005A probe and UXR-series real-time 
oscilloscope.

Software Component to be 
Used

Step

Infiniium GUI 1 Perform steps 1 to 4 described in the previous topics of this chapter. Do not perform dark 
calibration using Infiniium GUI because for TDECQ measurement, you need to perform the 
dark calibration on the FlexRT GUI.

Infiniium GUI 2 Launch the FlexRT GUI on the UXR real-time oscilloscope or from a remote PC connected to 
the oscilloscope using:

• Either Analyze > Launch FlexRT from the Infiniium GUI menubar.

• Or by double-clicking the FlexDCA software’s desktop shortcut. 

FlexRT GUI 3 If you are running FlexRT from a remote PC, click Setup > Infiniium Connection Setup to connect 
FlexRT to the UXR real-time oscilloscope. 

If you are running FlexRT on the UXR oscilloscope, a connection is automatically established 
between the oscilloscope and FlexRT on launching the FlexRT GUI.

Once a connection is established, a default setup and an auto-trigger in Infiniium are used. 
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FlexRT GUI 4 To quickly configure FlexRT settings including TDECQ Reference Equalizer Setup, load the 
FlexDCA instrument demo setup file available for N7005A by clicking File > Open Instrument 
Setup. You can either retain the default settings in this setup file or change as per your 
requirements. 

Alternatively, you can manually configure the Timebase, Acquisition, Clock Recovery, and 
TDECQ Equalizer setup using the Infiniium Scope Setup and TDECQ Reference Equalizer Setup 
dialog boxes. 

FlexRT GUI 5 Verify the channel settings such as reference filter and wavelength configured for your optical 
channel on FlexRT using Setup > Module > UXR040X: Channels.... If needed, you can change 
these settings. 

FlexRT GUI 6 For TDECQ measurement using FlexRT, you should NOT perform dark calibration in Infiniium 
GUI. You need to use the dark calibration available in the FlexRT GUI because it measures the 
intrinsic noise as well, which is required for a valid TDECQ measurement. Additionally, it also 
calibrates at multiple scales/offsets. Therefore, it remains valid when the scale/offset 
changes.

If the dark calibration has not been performed or is not current, the Status of the TDECQ 
measurement is displayed as ?.

To correct the TDECQ measurement status:

a Disconnect or disable optical signal to the N7005A.

b Turn off the TDECQ equalizer on FlexRT.

c Perform an autoscale using the Auto Scale button to adjust the vertical scale and offset so 
that the displayed signal uses the full display. 

d Perform dark calibration on the optical channel by clicking Tools > Calibration in FlexRT GUI. 
It will determine the dark level and the intrinsic noise in the current configuration. A 
configuration change such as sample rate or filter rate change causes dark cal to go 
invalid. 

e Turn on the optical signal and TDECQ equalizer.

FlexRT GUI 7  View the TDECQ measurement results in the Results table.

Software Component to be 
Used

Step
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This chapter provides information on the optical measurements that you can make using the 
N7004A / 5A on an Infiniium real-time oscilloscope. 
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Optical Measurements Supported

You can make the following optical measurements with N7004A or N7005A using the appropriate 
software as listed in the table below.

Optical Measurement Description O/E Converter to be Used Software to be Used

For NRZ/PAM2 Signals

Optical Average Power Optical power is a measure of the true average 
component of an optical signal.
it differs from other measurements because it does 
not rely on the waveform display to determine the 
measurement result. The analog-to-digital 
converter in the N7004A allows the generation of 
this result independent of the waveform displayed 
on the screen.

N7004A or N7005A Infiniium software GUI

Optical Modulation 
Amplitude (OMA) 

Optical Modulation Amplitude (OMA) is the 
measure of the difference between the optical 
power of an NRZ (non-return-to-zero) one pulse 
and the optical power of an NRZ zero pulse.

N7004A or N7005A Infiniium software GUI

Eye One Level Eye one level is a measure of the mean value of the 
logical 1 of an eye diagram.

N7004A or N7005A Infiniium software GUI

Eye Zero Level Eye zero level is a measure of the mean value of the 
logical 0 of an eye diagram.

N7004A or N7005A Infiniium software GUI

Extinction Ratio Extinction Ratio is the ratio of the one level and the 
zero level of an eye diagram of an optical signal.

N7004A or N7005A Infiniium software GUI

For PAM4 Signals

Outer Optical 
Modulation Amplitude 
(OMA)

Outer OMA is the measure of the difference 
between the optical power of a PAM4 signal's level 
3 and level 0 symbols.

N7005A Infiniium software GUI
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Outer Extinction Ratio 
(ER)

Outer ER is the ratio of a PAM4 optical signal eye 
diagram's level 3 and level 0 symbols.

N7005A Infiniium software GUI

Transmitter Dispersion 
and Eye Closure 
Quaternary (TDECQ) 

TDECQ is the indicator of your optical transmitter’s 
performance relative to an ideal transmitter. It 
compares the Symbol Error Ratio (SER) 
performance of your transmitter to a virtual ideal 
transmitter.
TDECQ measures the increase of optical power 
required for the measured optical transmitter to 
achieve the same eye opening as the ideal optical 
transmitter. The lower the TDECQ measurement, 
the higher the quality of the measured transmitter. 

N7005A FlexRT software GUI (see 
page 37) and 
Infiniium software GUI

• Refer to the Optical Measurements help topics in the online help of your Infiniium real-time oscilloscope to get a detailed description of each of these 
measurements. 

• Refer to the online help integrated with the FlexRT software to get a detailed description of the TDECQ measurement. 

Optical Measurement Description O/E Converter to be Used Software to be Used
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N7004A Optical Measurement Results

The following screens display sample optical data and optical measurements results as displayed on 
an Infiniium oscilloscope connected to N7004A. 

Examples of Optical Data Acquired with N7004A for Different Optical Data Rates

For 10 Gbps data rate
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For 25 Gbps data rate
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N7005A Optical Measurement Results

The following screen displays sample optical data and optical measurements results for a 53.125 
Gbaud PAM4 signal acquired using N7005A with a UXR-series 70 GHz oscilloscope. (Note: For this 
sample screen, FFE equalization is enabled on the oscilloscope.)



N7004A / 5A Optical-to-Electrical-Converters User’s Guide 45

Making Optical Measurements and Analyzing Results 3

Performing Eye Mask Testing

When using the N7004A / 5A, you can use the mask testing feature of the Infiniium oscilloscope to 
verify whether or not a displayed eye diagram complies with industry-standard definitions for optical 
waveforms. A mask (template) defines the shaded mask regions in the display. A waveform must 
remain outside these mask regions to meet the requirements of a standard. A data point from a 
waveform that illuminates a pixel in the mask region causes a mask test failure. 

Types of Masks Supported with N7004A / 5A

You can:

• either load standard masks (for Keysight DCA oscilloscopes). These are provided with the Infiniium 
software for optical waveforms. These masks have the .mskx extension and are available at the 
following location:

C:\Users\Public\Documents\Infiniium\Masks

• or create your own masks and load these in the Infiniium software.

• or use the Automask or the Draw Mask feature of the oscilloscope.

Mask Margins

You can also enable mask test margins to ensure that mask testing is performed using the defined 
margins. 

The following screen displays optical data with a standard mask applied. Mask regions are shown in 
lighter shade of gray and mask margins are shown in darker shade of gray.

You use the Mask Test dialog box to enable and load a mask and the Mask Test Margins dialog box to 
enable and specify margins for the mask.

To know in detail how you can implement mask testing and mask margins on your Infiniium 
oscilloscope, refer to the Mask Testing help topics in the Infiniium online help. You can also click the 

icon displayed in these dialog boxes.

Mask RegionMask Margin 
Region

Mask Test panel 
with results
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4 Remotely Controlling the 
N7004A / 5A Measurement 
Setup

You can use the Remote Programming SCPI commands described in this chapter to remotely control 
the oscilloscope from a controller PC for:

• configuring the N7004A / 5A setup such as channel's bandwidth limit filter response.

• adding optical measurements and querying for these measurements’ results.

• configuring eye mask testing.
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Sample Remote Control Setup of N7004A / N7005A

NOTE
Before you can start remotely controlling the N7004A / 5A setup using SCPI commands, 
ensure that you have:

- installed the Keysight IO Libraries Suite software on the controller PC.

- connected the oscilloscope to the controller PC using USB, LAN, or GPIB.

- verified the oscilloscope connection.

To get detailed information on the above-mentioned points or on basic program 
communications, interface, syntax, data types, and status reporting, refer to your 
oscilloscope’s Programmer’s Guide.
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SCPI Commands for Controlling the N7004A / N7005A Setup

This topic includes only those SCPI commands that are unique to the N7004A / N7005A usage 
scenarios. The complete list of SCPI commands for remotely controlling you oscilloscope is available 
in your oscilloscope’s Programmer’s Guide.
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:MEASure:OPOWer

Command Syntax :MEASure:OPOWer [<source>][,{WATT | DBM}]

where:

• <source> can be {CHANnel<N> | DIFF<D> | COMMonmode<C> | FUNCtion<F> | WMEMory<R> 
|CLOCk | MTRend | MSPectrum | EQUalized}

• {WATT | DBM} - Specifies the measurement units in Watts or dBm.

Description The :MEASure:OPOWer command installs an Optical Average Power measurement into the user 
interface's measurement Results pane.

Optical average power is a measure of the true average component of an optical signal. If markers 
are tracking this measurement, the marker is placed on the optical power Watts. This measurement 
is commonly used when identifying the fundamental parameters of a lightwave transmitter. However, 
it differs from other measurements because it does not rely on the waveform display to determine the 
measurement. The analog-to-digital converter is in the probe itself, independent of the waveform 
displayed on the screen. You can measure the optical power of an eye diagram.

Query Syntax :MEASure:OPOWer? [<source>][,{WATT | DBM}]

The query returns the measured Optical Average Power.

Query Response
Format

[:MEASure:OPOWer] <value>[,<result_state>]<NL>

where:

• <value> is the measured Optical Average Power value.

• <result_state> - If SENDvalid is ON, the result state is returned with the measurement result. See 
the :MEASure:RESults table in your oscilloscope’s programmer’s guide for a list of the result 
states.
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:MEASure:CGRade:OLEVel

Command Syntax :MEASure:CGRade:OLEVel [<source>]

where:

• <source> can be {CHANnel<N> | DIFF<D> | COMMonmode<C> | FUNCtion<F> | WMEMory<R> 
|CLOCk | MTRend | MSPectrum | EQUalized}

• If <source> is omitted, the Q-factor will be performed on the first waveform that has color grade 
enabled.

Description The :MEASure:CGRade:OLEVel command installs an Eye One Level measurement into the user 
interface's measurement Results pane. Eye one level is a measure of the mean value of the logical 1 
of an eye diagram.

Before using this command or query, you must use the :DISPlay:CGRade command to enable the 
color grade persistence feature. Also, there must be a full eye diagram on screen before a valid 
measurement can be made.

Query Syntax :MEASure:CGRade:OLEVel? [<source>]

The query returns the measured Eye One Level.

Query Response
Format

[:MEASure:CGRade:OLEVel] <value>[,<result_state>]<NL>

where:

• <value> is the measured Eye One Level value.

• <result_state> - If SENDvalid is ON, the result state is returned with the measurement result. See 
the :MEASure:RESults table in your oscilloscope’s programmer’s guide for a list of the result 
states.
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:MEASure:CGRade:ZLEVel

Command Syntax :MEASure:CGRade:ZLEVel [<source>]

where:

• <source> can be {CHANnel<N> | DIFF<D> | COMMonmode<C> | FUNCtion<F> | WMEMory<R> 
|CLOCk | MTRend | MSPectrum | EQUalized}

• If <source> is omitted, the Q-factor will be performed on the first waveform that has color grade 
enabled.

Description The :MEASure:CGRade:ZLEVel command installs an Eye Zero Level measurement into the user 
interface's measurement Results pane. Eye zero level is a measure of the mean value of the logical 0 
of an eye diagram. Before using this command or query, you must use the :DISPlay:CGRade 
command to enable the color grade persistence feature. Also, there must be a full eye diagram on 
screen before a valid measurement can be made.

Query Syntax :MEASure:CGRade:ZLEVel? [<source>]

The query returns the measured Eye Zero Level.

Query Response
Format

[:MEASure:CGRade:ZLEVel] <value>[,<result_state>]<NL>

where:

• <value> is the measured Eye Zero Level value.

• <result_state> - If SENDvalid is ON, the result state is returned with the measurement result. See 
the :MEASure:RESults table in your oscilloscope’s programmer’s guide for a list of the result 
states.
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:MEASure:OMAMplitude

Command Syntax :MEASure:OMAMplitude [<source>][,{WATT | DBM}]

where:

• <source> can be {CHANnel<N> | DIFF<D> | COMMonmode<C> | FUNCtion<F> | WMEMory<R> 
|CLOCk | MTRend | MSPectrum | EQUalized}

• {WATT | DBM} Specifies the measurement units in Watts or dBm.

Description The :MEASure:OMAMplitude command installs an Optical Modulation Amplitude (OMA) 
measurement into the user interface's measurement Results pane. Optical Modulation Amplitude 
(OMA) is the measure of the difference between the optical power of an NRZ (non-return-to-zero) 
one pulse and the optical power of an NRZ zero pulse. It requires an NRZ pattern and is designed to 
be used with a square wave made of consecutive zeros followed by consecutive ones. Be sure to 
check any relevant standard for one and zero run requirements. All instances are measured if 
Measure All Edges is selected. Otherwise, the edges closest to the timebase reference are measured.

Query Syntax :MEASure:OMAMplitude? [<source>][,{WATT | DBM}]

The query returns the measured Optical Modulation Amplitude (OMA).

Query Response
Format

[:MEASure:OMAMplitude] <value>[,<result_state>]<NL>

where:

• <value> is the measured Optical Modulation Amplitude (OMA) value.

• <result_state> - If SENDvalid is ON, the result state is returned with the measurement result. See 
the :MEASure:RESults table in your oscilloscope’s programmer’s guide for a list of the result 
states.
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:MEASure:ERATio 

Command Syntax :MEASure:ERATio [<source>[,{RATio | DB | PERCent}]]

where:

• <source> can be {CHANnel<N> | DIFF<D> | COMMonmode<C> | FUNCtion<F> | WMEMory<R> 
|CLOCk | MTRend | MSPectrum | EQUalized}

• {RATio | DB | PERCent} Specifies the measurement units in Ratio, Decibel, or Percentage.

Description The :MEASure:ERATio command installs an Extinction Ratio measurement into the user 
interface's measurement Results pane. Extinction Ratio is the ratio of the one level and the zero level 
of an eye diagram of an optical signal.

Query Syntax :MEASure:ERATio? [<source>[,{RATio | DB | PERCent}]]

The query returns the measured extinction ratio.

Query Response
Format

[:MEASure:ERATio] <value>[,<result_state>]<NL>

where:

• <value> is the measured extinction ratio value.

• <result_state> - If SENDvalid is ON, the result state is returned with the measurement result. See 
the :MEASure:RESults table in your oscilloscope’s programmer’s guide for a list of the result 
states.

NOTE
The :MEASure:ERATio query returns a ‘?’ on the extinction ratio measurement if:

- The dark calibration has not been performed at all.

- The vertical sensitivity, offset, or sample rate of the oscilloscope has changed since the dark 
calibration was run.

- The N7004A /5A’s temperature has changed by > 2 oC.
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This chapter describes how to verify the bandwidth performance of the N7004A / 5A against the 
bandwidth specification (as listed on page 15).
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For N7004A

Test Strategy

The basic method for verifying the bandwidth of the N7004A is to use a femtosecond pulse laser. 
These types of laser sources output a very fast impulse that is much faster than the impulse response 
of the N7004A thus allowing measurement of the N7004A bandwidth without de-embedding the 
laser impulse response. Verification of the laser source is not considered in this testing but can be 
typically verified with an optical sampling scope or other optical methods.

Test Interval

The Keysight return-to-factory recertification interval to warrant performance of N7004A is 1 year. 
However, you can also test the N7004A bandwidth performance as and when required using the 
recommended test equipment and by following the procedure documented in this chapter. 

Test Equipment

A list of the recommended test equipment is provided. The instructions in this chapter are written 
with the presumption that you are using these recommended test equipment. You can substitute 
these equipment with equivalent equipment that satisfy the specifications given. However, results 
with substituted equipment may or may not yield identical results.

NOTE
The performance verification testing is also performed at the Keysight Technologies as part of 
the return-to-factory recertification to warrant performance. 

You can either test the N7004A bandwidth performance using the recommended test 
equipment and by following the procedure documented in this chapter. Or you may want to 
send your N7004A to the Keysight Technologies to get the bandwidth performance verification 
done by specialized Keysight staff. 

Test Equipment Model #

Calmar femtosecond pulse laser
(Qty 1)
This laser source has two outputs; 
• a 1560 nm port for testing longer wavelengths (i.e. 1310 and 1550nm) 
• a 780 nm port for testing shorter wavelengths (i.e. 760 and 850nm)

FPL-02RFFAGT12 

Keysight Lightwave Multimeter 2 slot mainframe (or other Keysight mainframe with more 
slots)
(Qty 1)

8163B

Keysight single-mode optical attenuator module for use in mainframe
(Qty 1)

81570A

Keysight multimode optical attenuator module for use in mainframe
(Qty 1)

81578A

L-Com 1m single-mode FC/FC patch cables (or equivalent)
(Qty 2)

SFOFC-01 

L-Com dual multimode FC/FC patch cable (or equivalent) which can be separated into two 
single cables for use in this procedure
(Qty 1)

FODFC50-01

Infiniium oscilloscope 33 GHz Infiniium oscilloscope
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Test Procedure

1 Install 81570A SM attenuator and 81578A MM attenuator in 8163B frame.

2 Turn on Calmar laser (but not the keyed "Pump Laser"), Infiniium oscilloscope, and 8163B frame.

3 Connect N7004A to be tested to channel 1 of the oscilloscope.

4 Let all equipment warm up for 45 minutes.

5 Set both attenuators for the maximum attenuation of 60db.

6 While observing cleaning procedures, connect optical output A (760nm) to the input of the MM 
81578A using the multimode patch cable.

7 While observing cleaning procedures, connect optical output B (1560nm) to the input of the MM 
81570A using the single mode patch cable

8 Perform a default setup on the oscilloscope.

9 While observing cleaning procedures, connect the output of the 81578A to the N7004A using a 
multimode patch cable.

10 Under Setup Probe Configuration, select Options for the N7004A on channel 1 and select 850 nm.

11 Enable the 81578A attenuator by pressing the button on the front of the module. This allows the 
laser light through the attenuator.

12 Turn on the keyed Pump Laser on the Calmar laser and adjust the Pump Current to maximum. 

13 Set up the oscilloscope as follows:

• Trigger on channel 1, level 500 uW

• Timebase to 200 pS/div

• Channel 1 to 500 uW/div

• In Setup Acquisition, set for average mode with 1024 averages

14 Begin lowering the attenuation on the 81578A until an impulse is seen. Lower it until the 
amplitude of the impulse is 1.5 to 2 mW.

CAUTION
The Calmar pulse laser used in this procedure outputs a large impulse that 
could damage the input of the N7004A. As described in the procedure 
below, set the optical attenuators to the maximum attenuation before 
enabling the optical attenuators and then lower the attenuation until a 1.5 
to 2 mW signal is seen on the oscilloscope’s screen.

CAUTION
Before making the connections between the fiber-optic connectors using 
a single-mode or a multimode patch cable, you must clean the fiber ends 
of these connectors and the mating fiber-optic cable. To get details on the 
cleaning procedure, refer to the topic, “Step 1 - Clean the Fiber-Optic 
Connectors" on page 20

NOTE
The Calmar laser may produce a "double” (multiple) pulse when the pump laser is set to 
maximum. If it does, then lower the pump laser setting until the "double" pulse stops. 

Single pulse outputs are stable with pulses evenly spaced in time. Multiple pulse outputs 
have arbitrary time delays between adjacent pulses. For details on single and multiple pulse, 
refer to the Calmar user manual. 
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15 Change the timebase to 2 nS/div.

16 Invoke a frequency response (FFT) on channel 1 using Math/New FFT/Channel1 from the pull down 
menu.

17 Set the FFT scale to 3 db/div and adjust the FFT offset to get the left hand side of the FFT 
waveform (0 to 4 GHz) at center screen. To do this, grab the FFT waveform with the left mouse 
button and move it to center screen. See Figure 5.

Figure 5 Upper trace: N7004A impulse response. Lower trace: FFT of impulse showing bandwidth

Verify that the FFT is not down more than 3 db at 32 GHz. For instance, in the sample screen 
above, the response is still at 0db at 32 GHz.

18 Disable the 81578A attenuator.

19 While observing cleaning procedures, connect the output of the 81570A to the N7004A using a 
single mode patch cable.

20 Under Setup Probe Configuration, select Options for the N7004A on channel 1 and select 1550 nm.

21 Enable the 81570A attenuator by pressing the button on the front of the module. This allows the 
laser light through the attenuator.

22 Begin lowering the attenuation on the 81570A until an impulse is seen. Lower it until the 
amplitude of the impulse is 1.5 to 2 mW,
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23 If needed, center the FFT waveform as done earlier in this procedure.

Verify that the frequency response (FFT) is not down more than 3 db at 32 GHz.

24 Disable the 81570A attenuator.

This completes the bandwidth performance verification testing for N7004A.

NOTE
The Calmar laser may produce a "double” (multiple) pulse when the pump laser is set to 
maximum. If it does, then lower the pump laser setting until the "double" pulse stops. 

Single pulse outputs are stable with pulses evenly spaced in time. Multiple pulse outputs 
have arbitrary time delays between adjacent pulses. For details on single and multiple pulse, 
refer to the Calmar user manual. 
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For N7005A

Test Strategy

The basic method for verifying the bandwidth of the N7005A is to use a femtosecond pulse laser. 
These types of laser sources output a very fast impulse that is much faster than the impulse response 
of the N7005A thus allowing measurement of the N7005A bandwidth without de-embedding the 
laser impulse response. Verification of the laser source is not considered in this testing but can be 
typically verified with an optical sampling scope or other optical methods.

Test Interval

The Keysight return-to-factory recertification interval to warrant performance of N7005A is 1 year. 
However, you can also test the N7005A bandwidth performance as and when required using the 
recommended test equipment and by following the procedure documented in this chapter. 

Test Equipment

A list of the recommended test equipment is provided. The instructions in this chapter are written 
with the presumption that you are using these recommended test equipment. You can substitute 
these equipment with equivalent equipment that satisfy the specifications given. However, results 
with substituted equipment may or may not yield identical results.

NOTE
The performance verification testing is also performed at the Keysight 
Technologies as part of the return-to-factory recertification to warrant 
performance. 

You can either test the N7005A bandwidth performance using the 
recommended test equipment and by following the procedure documented 
in this chapter. Or you may want to send your N7005A to the Keysight 
Technologies to get the bandwidth performance verification done by 
specialized Keysight staff. 

Test Equipment Model #

Calmar femtosecond pulse laser with the following output:
• a 1560 nm port for testing longer wavelengths (1310 and 1550 nm) 
(Qty 1)

FPL-02RFFAGT12 

Keysight Lightwave Multimeter 2 slot mainframe (or other Keysight 
mainframe with more slots)
(Qty 1)

8163B

Keysight single-mode optical attenuator module for use in mainframe
(Qty 1)

81570A

L-Com 1 m single-mode FC/FC patch cables (or equivalent)
(Qty 2)

SFOFC-01 

Infiniium oscilloscope Keysight 70 GHz UXR oscilloscope with 1.85 mm 
M inputs + N5520B 1.85 mm F-1.85 mm F adapter
Or 
Keysight >70 GHz UXR oscilloscope with 1 mm M 
ruggedized inputs + Y1901B 1 mm F ruggedized 
to 1.85 mm F adapter
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Test Procedure

1 Install 81570A SM attenuator in 8163B frame.

2 Turn on Calmar laser (but not the keyed "Pump Laser"), ≥70 GHz Infiniium UXR Infiniium 
oscilloscope, and 8163B frame.

3 Connect N7005A to be tested to channel 1 of the oscilloscope.

4 Let all equipment warm up for 45 minutes.

5 Set the attenuator for the maximum attenuation of 60 db.

6 While observing cleaning procedures, connect optical output B (1560 nm) to the input of the MM 
81570A using the single mode patch cable.

7 Perform a default setup on the oscilloscope.

8 While observing cleaning procedures, connect the output of the 81570A to the N7005A using a 
single-mode patch cable.

9 Under Setup Probe Configuration, select Options for the N7005A on channel 1 and select 1550 nm.

10 Enable the 81570A attenuator by pressing the button on the front of the module. This allows the 
laser light through the attenuator.

11 Turn on the keyed Pump Laser on the Calmar laser and adjust the Pump Current to maximum. 

12 Set up the oscilloscope as follows:

• Trigger on channel 1, level 500 uW

• Timebase to 200 pS/div

• Channel 1 to 500 uW/div

• In Setup Acquisition, set for average mode with 4096 averages

13 Begin lowering the attenuation on the 81570A until an impulse is seen. Lower it until the 
amplitude of the impulse is 1.5 to 2 mW.

CAUTION
The Calmar pulse laser used in this procedure outputs a large impulse that 
could damage the input of the N7005A. As described in the procedure 
below, set the optical attenuators to the maximum attenuation before 
enabling the optical attenuators and then lower the attenuation until a 1.5 
to 2 mW signal is seen on the oscilloscope’s screen.

CAUTION
Before making the connections between the fiber-optic connectors using 
a single-mode patch cable, you must clean the fiber ends of these 
connectors and the mating fiber-optic cable. To get details on the 
cleaning procedure, refer to the topic, “Step 1 - Clean the Fiber-Optic 
Connectors" on page 20

NOTE
The Calmar laser may produce a "double” (multiple) pulse when the pump 
laser is set to maximum. If it does, then lower the pump laser setting until 
the "double" pulse stops. 

Single pulse outputs are stable with pulses evenly spaced in time. Multiple 
pulse outputs have arbitrary time delays between adjacent pulses. For 
details on single and multiple pulse, refer to the Calmar user manual. 
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14 Set the oscilloscope to:

• Timebase: 10 nS/div

• Manual memory depth: 16384

• Sample rate locked at 256 GSa/s

15 Invoke a frequency response (FFT) on channel 1 using Math/New FFT/Channel1 from the pull-down 
menu and set the window to rectangular. Set stop frequency to 100 GHz.

16 Set the FFT scale to 3 db/div and adjust the FFT offset to get the left-hand side of the FFT 
waveform (0 to 8 GHz) at center screen. To do this, grab the FFT waveform with the left mouse 
button and move it to center screen. See Figure 5.

Figure 6 Upper trace: N7005A impulse response. Lower trace: FFT of impulse showing bandwidth

Verify that the FFT is not down more than 3 db at 60 GHz. 

This completes the bandwidth performance verification testing for N7005A.
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6 Calibration Strategy

You need to perform dark calibration (see page 33) on N7004A / 5A whenever you change the 
vertical scale or offset of the oscilloscope. 

In addition to performing dark calibration, Keysight recommends that you also get the factory 
calibration done once in a year by sending the N7004A / 5A to the Keysight Technologies. Factory 
calibration also includes bandwidth performance verification testing (see page 55) for N7004A / 5A. 
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7 Troubleshooting

This chapter covers some common troubleshooting scenarios that you may find useful while using 
N7004A / N7005A. 
If the problem persists, contact Keysight Technologies. To locate a sales or a service office near you, 
go to www.keysight.com/find/contactus.
The service strategy for the N7004A / 5A is to send it to Keysight Technologies for all service work.
Keysight requires that the N7004A / 5A unit be repaired only at qualified repair facilities such as the 
Keysight Repair Centers.

Problem Possible Cause(s) Solution

Unable to make optical measurements 
using N7004A / 5A.

Multiple (as indicated in the flowchart 
provided in “Troubleshooting Flowchart 
section.)

Start at the top of the flowchart 
provided in “Troubleshooting Flowchart 
section. The flowchart directs you to the 
relevant steps.

The dark calibration failed. Refer to the topic “Reasons for the Failure of Dark Calibration" on page 35.

Problem in optical signal transmission Low transmitted power Check alignment of the optical cable 
into N7004A / 5A.
Ensure that the keying features of both 
the N7004A / 5A FC/PC Input connector 
and fiber-optic cable’s connector are 
aligned properly before you start 
finger-tightening the connection. 
Refer to the topic “Aligning the Keying 
Features while Making the 
Connection" on page 25.

Extinction ratio is out of range (that is, 
lower than expectations)

The optic connector of N7004A / 5A or 
optic cable is dirty and requires cleaning.

Clean the fiber-ends of both N7004A / 
5A as well as optic cable’s connectors 
as per instructions given in “Step 1 - 
Clean the Fiber-Optic Connectors" on 
page 20.

The Optical Average Power measurement 
displays the value “Responsivity?”

You have selected the User Defined 
wavelength option for N7004A / 5A. 

Manually specify and adjust the 
Responsivity value for N7004A / 5A. 
Refer to the topic “Adjusting Conversion 
Gain for a User-defined Wavelength" on 
page 28.

Erratic optical measurements are 
displayed.

The optic connector of N7004A / 5A or 
optic cable is dirty and requires cleaning.

Clean the fiber-ends of both N7004A / 
5A as well as optic cable’s connectors 
as per instructions given in “Step 1 - 
Clean the Fiber-Optic Connectors" on 
page 20.

www.keysight.com/find/contactus.
www.keysight.com/find/contactus.
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Troubleshooting Flowchart
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8 Returning the N7004A / 5A for 
Repair or Service

If the N7004A / 5A is found to be defective, we recommend sending it to a Keysight authorized 
service center for all repair and calibration needs.

Perform the following steps before shipping the N7004A / 5A back to Keysight Technologies for 
repair / service.

1 Contact your nearest Keysight sales office for any additional details.

2 Write the following information on a tag and attach it to the malfunctioning equipment.

• Name and address of owner

• Product model number (N7004A)

• Product Serial Number (for example, MYXXXXXXXX)

• Description of failure or service required

3 Protect the N7004A / 5A by wrapping in plastic or heavy paper. Use original packaging or 
comparable.

4 Pack the N7004A / 5A in the original carrying case or if not available, use bubble wrap or packing 
peanuts.

5 Place securely in sealed shipping container and mark container as "FRAGILE".

If any correspondence is required, refer to the product by serial number and model number.
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Contacting Keysight Technologies

For technical assistance, contact your local Keysight Call Center.

• In the Americas, call 1 (800) 829-4444

• In other regions, visit http://www.keysight.com/find/assist

Before returning an instrument for service, you must first call the Call Center.

http://www.keysight.com/find/assist
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9 Safety and Regulatory Infor-
mation

This product has been designed and tested in accordance with accepted industry standards, and has 
been supplied in a safe condition. The documentation contains information and warnings that must 
be followed by the user to ensure safe operation and to maintain the product in a safe condition.

Only Keysight approved accessories shall be used.

WARNING
If this product is not used as specified, the protection provided by the 
equipment could be impaired. 

WARNING
Do not attempt internal service or adjustment. Service should be carried out 
by a Keysight Technologies authorized service personnel. For any service 
needs, contact Keysight Technologies.

WARNING
Indoor Use Only. Do not operate in wet / damp environments. Keep product 
surfaces dry and clean.

Do not operate in an explosive environment.

CAUTION
The input circuitry of the N7004A / 5A can be damaged when total input 
power levels exceed 8 mW. To prevent damage, this specified level must not 
be exceeded.

CAUTION
Damage to the fiber-optic connectors can degrade measurement accuracy 
and repeatability and can cause expensive damage to instruments.
To avoid damage to the N7004A / 5A’s fiber-optic connector, ensure that 
you follow the cleaning techniques and the warnings and cautions included 
in the topic “Step 1 - Clean the Fiber-Optic Connectors" on page 20.
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Instrument Markings

Marking Description

The instruction documentation symbol. The product is marked with this symbol when it is necessary for 
the user to refer to the instructions in the documentation to protect against damage to the product or 
personal injury.

This symbol indicates the Environmental Protection Use Period (EPUP) for the product’s toxic substances 
for the China RoHS requirements.

This product complies with the WEEE Directive (2002/96/EC) marking requirements. The affixed label 
indicates that you must not discard this electrical/electronic product in domestic household waste. 
Product Category: With reference to the equipment types in the WEEE Directive Annex I, this product is 
classed as a “Monitoring and Control instrumentation” product. Do not dispose in domestic household. To 
return unwanted products, contact your local Keysight office, or refer to www.keysight.comfor more 
information. 
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Cleaning the N7004A / 5A

To clean the outer enclosures of N7004A / 5A:

1 Disconnect the N7004A / 5A from the oscilloscope and signal source.

2 Wipe it with a soft cloth dampened with a mild soap and water solution. Do not use too much 
liquid or any chemicals.

3 Make sure the N7004A / 5A is completely dry before reconnecting it to the oscilloscope.

Ensure that you follow the cleaning instructions provided for the fiber-optic connectors as these are 
very sensitive, easy to damage, and expensive to replace. Refer to the topic “Step 1 - Clean the 
Fiber-Optic Connectors" on page 20.
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